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An introduction to MATLAB 
MATLAB is a high-performance language for technical computing. Its name 
stands for matrix laboratory and its basic data element is the array. MATLAB 
also is an interactive system that consists of a Development Environment, a 
mathematical function library, graphics facilities, a programming language and 
facilities to interact with C and FORTRAN programs. 

This guide provides an introduction for beginners to some of the tools of the 
Development Environment and to the MATLAB programming language. 

Previous programming experience will be useful but is not essential. As 
MATLAB is oriented towards working with arrays and matrices basic 
knowledge of Linear Algebra is assumed. 
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In this document, the following conventions are used: 
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 A slanted typewriter font is used for items such as example filenames which 
you should replace with particular instances. 
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the text. 
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1 Introduction 

MATLAB is installed on the CIS Networked PC service (NPCS), the Linux 
Service (mira) and the HPC service (hamilton).  

1.1 Starting a MATLAB session 

On the NPCS computers MATLAB is available from the Start > Programs 
> Programming Languages > MATLAB menu. 

On the Linux service MATLAB is available from the desktop menu 
Applications > Science > Matlab or by typing matlab & at the prompt in a 
terminal window. 

Further information about availability can be found on the CIS MATLAB 
Application web page. 

1.2 Closing MATLAB 

The MATLAB application can be closed in various ways. The program will 
first ask whether any modified files have to be saved. It is also possible to 
close individual tools. 

The main application can be closed 

 By clicking the Close button in the top right side of the title bar. 

 Via the keyboard by pressing Ctrl/Q. 

 By typing quit at the Command Window prompt (Section 1.6). 

1.3 The MATLAB Desktop 

The Graphical User Interface (GUI) display of MATLAB is called the 
MATLAB Desktop. It contains various tools and windows where the user 
can interact with the program. Several of these components are outlined in 
the figure below. 

 

 

 

http://www.dur.ac.uk/its/software/application/?application=MATLAB
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At the top of the desktop is the title bar with the MATLAB release version. 
Underneath it is the Toolstrip with buttons for managing the various 
MATLAB tools. The pictures are called icons and their purpose is to give a 
visual hint to a button’s main function. 

The main area of the Desktop is the Command Window which is used for 
interaction with the MATLAB Tools.  

1.4 The Toolstrip 

The Toolstrip consists of a number of dynamically changing menu tabs. 
The HOME, PLOTS and APPS tabs are present by default, but additional 
tabs may appear depending on the particular MATLAB Tool that is currently 
active. 

 

At the bottom of the ribbon are the categories that are available for each 
tab, e.g. for the HOME tab these are FILE, VARIABLE, CODE etc. 

The icons (little pictures) on each tab are buttons that can be clicked to 
initiate an action. This can be a list of items or a dialogue box. Holding the 
mouse briefly over a button icon displays a Tooltip, a small window with 
some text giving a brief explanation of the function of the Button. 

Clicking on an item displays a list of sub-items to toggle a particular setting, 
or to let the program perform an action or display a further list of menu 
items.  

As an example the expanded New menu is shown here 
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It displays a list of document types from which a new document can be 
created. Where relevant some of the other button functions will be 
discussed in later sections. 

1.5 Desktop Tools 

The MATLAB Desktop contains tool windows for managing programs, files 
and applications associated with MATLAB. Some of the tools are 

Command Window 

Command History 

Current Folder 

Editor 

Workspace 

In this basic beginner’s guide only the first four tools of this list will be 
discussed in the next sections. 

Which tool windows are visible can be controlled with the Layout button on 
the ENVIRONMENT section of the HOME tab. 

 

This will open a sub-menu as shown next 
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1.6 The Command Window 

The Command Window is used to enter MATLAB statements and 
commands. It works like an ordinary command line window and commands 
are entered after the command prompt 

>> 

Commands can be entered from the keyboard, loaded from binary files 
using the load command or by opening an M-file. It is also possible to 
select and copy a previous command from the Command History window 
and paste it into the Command Window. 

1.6.1 Use of Arrow Keys 

Previous commands can be recalled with the up- and down-arrow keys.  

1.7 The Command History 

The Command History window records the commands that have been 
entered into the Command Window. The Command History displays a list 
of all these previously executed commands including those of previous 
sessions, separated by time stamps. A double click on a command will 
copy it to the Command Window and execute it. 

1.8 The Current Folder Browser 

The Current Directory browser window is self-explanatory (the default 
directory is your CIS home space), it acts as a navigation pane. 

1.9 The Editor Window 

The Editor sub-window enables the editing of MATLAB documents and is 
explained in Section 2.7.1. 

1.10 The Help Browser 

The Help Browser is an on-line help facility in HTML format.  It can be 
opened in several ways. 

 By clicking the help button ( ?  ) on the RESOURCES section of the 
HOME tab. 

 Pressing the F1 key on the key board. 

 Type doc in the Command Window1. 

The Help Browser window looks similar to this 

                                                           
1 In older versions of MATLAB the command is helpbrowser 
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1.11 Important short cut keys 

MATLAB gives the user the option what short cut keys to use for basic 
operations like copying and pasting, deleting and saving. These keys are 
combined in sets that conform to a particular environment, for example 
Windows and Emacs sets. The preference can be set in the Preferences 
dialogue box that can be opened by clicking the Preferences button on the 
HOME tab. 
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Selecting Keyboard > Shortcuts and clicking the current entry for Active settings 
provides a drop down list with Keyboard Set options. 
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2 Basic manipulations 

It is important to remember that, unlike in most other programming 
languages; MATLAB expressions involve operations on entire matrices and 
arrays. 

2.1 Variables 

MATLAB is case sensitive, this means for example that x and X are two 
different variables: 

x = 3, X = 5 

x = 

     3 

X = 

     5 

 

Assignment statements can be combined on a single line, separated by a 
comma. 
 

x + X 

ans = 

     8 

 

To view the value assigned to a variable, enter the variable name, 

x 

Note  

 The variable or expression is evaluated when the Return key is 
tapped. 

 MATLAB maintains a built-in variable ans which contains the value 

of the last expression evaluated that is not assigned to a variable. 

 MATLAB will print the result of the expression unless the expression 
is terminated with a semi colon (  ;  ). 
 
x = 3, X = 5 ; 

 Expressions can be combined on a single command line by using 
the comma separator or the semi colon (  ;  ). 

 An expression can be continued over several lines by adding three 
or more periods ( … )at the end of a line. 

Variable names consist of a letter followed by any number of letters, digits 
or underscores. Only the first 31 characters of a variable name are used 
to identify the variable. 

MATLAB does not require type declaration of variables or the dimensions 
of arrays. If a new variable is introduced MATLAB will decide its type at the 
moment one or more values are assigned. If a variable already has been 
assigned a value then changing its value may also change its type. 

x = 6; 

Here MATLAB will create a 1 by 1 array and store the value 6 in its single 
element.  
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2.2 Vectors 

To create a row vector MATLAB has the [ ] notation: 

x = [ 3 , 5 , -7  ] ; 

will now change x into a 1 by 3 array (a row vector). This is shown in the 
way MATLAB prints the vector 

x 

x = 

     3     5     -7 

Note that the row elements are separated with the comma character ( , ) 
although white space (by entering the Space bar on the keyboard) can also 
achieve this if it will not cause ambiguities. 

MATLAB distinguishes between row and column vectors. A column 
vector is created similarly to a row vector but with a semi-colon ( ; )as  
separator. 

y = [ 3 ; 5 ; -7  ] ; 

and 

y 

3 

5 

-7 

A row vector can be transformed into a column vector by transposition. The 
notation for the transposition operator is an apostrophe ( ‘ ) or single quote. 

x' 

ans = 

3 

5 

-7 

In this case MATLAB also prints the line ans = to indicate that the 

transpose is not an assignment, the vector x will not have changed. The 
assignment 

z = x’; 

will make z a column vector. 

Individual elements of a vector are addressed with a pair of parentheses ( ) 
enclosing the index of the required element: 

x(2) 

 5 

 
Note MATLAB counts starting from 1. 
 

2.3 Matrices 

Matrices can also be entered in the Command Window with the [ ] 
notation. They are entered on a row by row basis where rows are 
separated by a semi colon ( ; ) in the same way as creating a column 
vector. The following statement will make A into a 4 by 3 matrix (4 rows and 
3 columns), 
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A = [ 3 5 7; 2 4 6 ; 3 4 5 ; 11 8 6 ] 

A = 

     3     5     7 

     2     4     6  

     3     4     5 

    11     8     6 

Its transpose is 

A' 

ans = 

     3     2     3    11 

     5     4     4     8 

     7     6     5     6 

Individual elements of a matrix are also addressed with a pair of 
parentheses ( ) with the indices of the element, first its row index, then its 
column index separated by a comma 

A(2,3) 

 4 

2.4 The colon operator  

The colon operator (symbol is : ) can be used to define a range of values. 
For example  

x = 1 : 1 : 10 

sets x as a vector of length 10 with the values 1 to 10 in steps of 1. The 

general format is 

start  :  step  :   end 

If the middle value step is omitted MATAB uses as default a step value 1. 
The variables do not necessarily have to be positive integers; they can be 
negative and in general any real numbers. 

 

2.5 Matrix and Vector algebra 

As MATLAB is a matrix algebra oriented package some of the familiar 
arithmetic operations behave differently from what one would expect when 
working with numbers (scalars). The standard characters for multiplication 
and division, * and / have a different meaning in MATLAB; they now stand 
for the corresponding operations of matrix algebra. The same holds for the 
exponentiation operator, ^ 

For example if another vector y is added to the vector x defined before, the 
two vectors are added element by element: 

x = [ 3 , 5 , -7  ] ; 

y = [ -1 , 6, 7 ] ; 

x + y 

ans = 
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     2    11    0 

Similarly for the operation of subtraction 

x - y 

ans = 

     4    -1     -14 

The same rules of addition and subtraction apply to matrices. 

The multiplication operator * for two vectors can have different meanings, it 
could be the element by element multiplication of the vectors, giving a new 
product vector of the same length, or, it could be the scalar product which 
is the sum of the elements of the product vector. MATLAB uses the * for the 
latter 

x * x' 

ans = 

    83 

whereas the operator for element by element multiplication is .* which will 
return a vector with the same length as x 

x .* x 

ans = 

     9    25    49 

The built-in function sum calculates the sum of columns in a vector or array 

sum ( x .* x ) 

ans = 

    83  

The same rules apply to matrix-vector and matrix-matrix multiplication. For 
example set the vector x and matrix A as 

x = [ 3 , 5 , -7  ] ; 

and 

A = [ 3 5 7; 2 4 6 ; 3 4 5 ; 11 8 6 ] 

Then the matrix-vector multiplication 

A * x' 

ans = 

    -15 

    -16 

     -6 

     31 

Note MATLAB will check that the dimensions of vectors and matrices 
conform to the rules of matrix algebra. If not it will report an error. 

It is not required to specify the size of an array in advance but as changing 
the size takes processor time, the size can be specified if known in 
advance with the zeros function 
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B = zeros ( 4, 3 ); 

and followed by assignment statements. 

2.6 Some special Matrices 

MATLAB has a number of built in functions to generate some of the 
common matrices. Examples are 

 Null matrix, with all elements set to zero. To initialize a matrix with n 
rows and m columns use  
 
x = zeros ( n , m ) ; 

 A matrix with ones for every element 
 
x = ones ( n , m ); 

 The unit or identity matrix eye. This is a matrix with zeros 
everywhere except for ones on its diagonal 
 
x = eye ( n , m ); 
 
and similarly, 
 
x = eye ( n ); 
 
returns a n by n identity matrix. 

2.6.1 Some Examples of Matrix Operations on Square Matrices. 

MATLAB supplies a number of built-in functions and M-files that solve 
problems in Linear Algebra defined with matrices. Below are some 
examples of functions for square matrices. (A square matrix has an equal 
number of rows and columns). 

The inverse of a square matrix A can be calculated with the inv function 

inv ( A ) 

This could be used to solve a system of linear equations as for example  

𝐴 𝑥 = 𝑏   

where the matrix A and the vector b on the right hand side are 

A = ( 
1.1 −3.0 4.0
0.8 2.3 −5.5
3.7 1.8 0.5

 )  ,   b = ( 
1
0

−1
 )  

These equations can be solved for 𝑥 with 

x = inv(A) * b 

The eigenvalues of a square matrix can be calculated with the function eig 
as for example  

eig ( A ) 

2.7 Scripts, Functions and M-files 

MATLAB provides a large number of intrinsic or built-in functions 
corresponding to the commonly used functions in mathematics. 
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The user can also create reusable code in the form of M-files. M-files are 
text files that contain MATLAB statements. To indicate this, their name 
should end with the .m extension. Two kinds of M-files can be 
distinguished, depending on the content of the file: 

 Scripts. 
These contain lines of code that are executed as if they had been 
entered directly in the Command Window. They do not accept input 
arguments nor return output arguments but can use variables that 
have been defined before the script is invoked. 

 Functions. 
These accept input arguments and can return output arguments. 
Variables created inside the function are local to the function. 
 

A MATLAB script is invoked by typing the name of the script which should 
be the name of the M-file with the .m extension removed. The type 
command in the Command Window lists the content of an M-file.  

Example 

MATLAB comes with a collection of functions that are actually M-files and 
one of these is the factorial function. The way it is coded in MATLAB can 
be shown by entering the command type followed by the name of the 
function 

type factorial 

The help command explains what this function does 

help factorial 

2.7.1 The MATLAB Editor 

The MATLAB desktop provides a built-in editor to create and modify scripts, 
M-files and other documents. To create a new document with the editor 
click on the New menu of the HOME tab as shown in section 1.4. Additional 
tabs will appear on the Toolstrip with the EDITOR as the active tab. The 
editor window will initially display an empty area where MATLAB 
statements can be entered as for example here 
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When finished editing the file can be saved with the Ctrl/S keystrokes or by 
clicking the Save button on the Command Toolbar. 

An existing file can be opened from the Navigator pane by right clicking 
and selecting the Open menu item 

 

2.7.2 Comments 

As soon as a program is stored in a file for later re-use it becomes 
important to add comments everywhere in order to make the meaning and 
intent of the program clear. In MATLAB all lines that start with the 
percentage character ( % ) are treated as comments. These comments can 
be viewed by the user with the help command. 

2.7.3 Scripts 

When a MATLAB script is invoked by typing the name of the script (file) 
without the .m extension MATLAB will execute the statements as if they 
were entered in the Command Window. The statements in the script can 
refer to already existing variables or create new variables which can be 
used in statements entered after the script has returned.  

The  following is an example.  

x = 1 : 1 : 20; % define a vector with a range of values 

r = rand ( size ( x ) ); % get a random number between 0 and 

1  

% for each value of x  

colormap ( [ 0.8 0.8 0.8 ] ); % default colour is a shade of 

grey 

bar ( r ); % plot as a bar graph  

If these MATLAB commands are entered in the Editor and saved as the   
M-file uniform_bar.m, the content of the file can be displayed in the 
Command window by entering 

type uniform_bar 
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The script can be executed by typing the statement 

uniform_bar 

This will display the random numbers as a bar graph in the Figures 
Window, see below. (Note that the content of the plot will vary every time 
the script is called because it is generated from random numbers.) 

 

2.7.4 Functions 

MATLAB functions combine groups of statements into a single unit of code 
that can be re-used for different input values. They have the following 
format, starting with the keyword function 
 
function  [ output_variables  =  ]   function_name  (   input_variables  ) 
 
    matlab_statements 

 
The arguments of a MATLAB function are therefore always used for input 
only. If output from a function is required it must be retrieved through the 
values returned in the output_variables.  

Note The name of the M-file (without the .m extension) and that of the 
function must be the same; otherwise an error message will result. 

The following is an example of a function free_fall_time that calculates the 
free fall time in seconds for an object falling from a height h in meters 

function t = free_fall_time ( h ) 

g = 9.8; 

t = sqrt ( 2.0 .* h ./ g ); 

 

This code can be entered with the Editor in a file which must be called 
free_fall_time.m  

To call the function enter its name supplied with a value for its argument 
between round brackets. 

free_fall_time ( 10000 ); 

ans = 

   45.1754 
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2.7.5 Functions and Global Variables. 

By default variables referred to inside a function are local and independent 
of any variables with the same name that may exist outside the function. 

There is a special type of variable that can be created outside a function 
(for instance in a script or in the Command Window) and be accessed from 
within functions. 
The keyword global is used for this; this provides a facility for different 
functions to share data. 
 
For example the following function returns the terminal velocity in a free fall, 
given the height of falling 

function v = free_fall_v ( h ) 

global G; 

v = sqrt ( 2.0 .* G  .* h ); 

 
This can be used with a value of G set beforehand, as follows 
 
global G 

G = 9.8; 

free_fall_v ( 10000 ) 

ans = 

  442.7189 

NOTE The global variable must be declared global both in any M-files that 
wish to use it and in the Command Window if it will be used in subsequent 
statements. The assignment of a value to a global variable and its 
declaration must be in two separate statements. 

2.7.6 Functions that return multiple values (output variables) 

MATLAB functions can return multiple values in the form of vectors, 
matrices or arrays. An example is a function that returns both the time and 
terminal velocity of a free fall. 

function [ t , v ] = free_fall ( h ) 

g = 9.8; 

t = sqrt ( 2.0 .* h ./ g ); 

v = g .* t; 

This function is called as follows 

[ t , v ] = free_fall ( 10000 ) 

t = 

   45.1754 

v = 

  442.7189 

In the function definition the output arguments have been defined as a 
vector with two components, t and v. On calling the function a vector 
compatible with the output variables is used as the left hand side to store 
the returned values. 
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This mechanism can be generalized to much more complicated output 
structures. 

Note Built-in function names are not reserved keywords in MATLAB. It is 
legal to redefine or overwrite any MATLAB variables and built-in functions. 
The original variable or function can be restored with the clear command. 

Example: 

pi 

ans = 

    3.1416 

pi = - 3.1416 

pi = 

   -3.1416 

clear pi 

pi 

ans = 

    3.1416  

2.7.7 Subfunctions 

Often it is better to break up a function into several smaller independent 
logical units. These helper functions are called subfunctions in MATLAB. 
The function that has the M-file name is called the primary function and it 
is the only function that can be invoked from the M-file; any subfunctions 
are only accessible by the primary function and any other subfunctions in 
the same file. 

 The primary function has to appear first in the M-file, subfunctions 
can follow in any order. 

 Functions within the same M-file cannot access the same variable 
unless it is declared as global or passed as an argument. 

 The help facility will only provide the help for the primary function. 

Example 

function [ avg , med ] = mystats ( x ) % the primary function 

global n ; 

 

n = length ( x ) ; 

% invoke subfunctions: 

avg = mean ( x ); 

med = median ( x ); 

 

% here are the subfunctions defined: 

function a = mean ( v ) 

global n ; 

a = sum ( v ) / n; 

 

function m = median ( v ) 

global n ; 

w = sort ( v ) ; 

if rem ( n, 2 ) == 1 
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    m = w ( ( n + 1 ) / 2) ; 

else 

    m = ( w(n/2) + w(n/2+1))/2; 

end 

 

Functions will be discussed in more detail in Section 4. 

2.8 Exercises 

2-1 What happens if the following commands are entered? 

x’ * x 

(Note, x’ is the transpose of x) 

A * x 

2-2 Enter the complex 2 by 2 matrix 

 2 – i 1+i 

 3 i 5 

What is the difference between the conjugation operators ‘ and .’? 

2-3 Use the Editor to create a M-file for the uniform_bar script of Section 
2.3.2 and repeatedly run it. The graph will change in a random way. 

2-4 Use the Editor to create a M-file with a function that has two arguments, 
the height h and the acceleration of gravity, g, to calculate the fall time and 
terminal velocity. 

3 Graphics 

3.1 Introduction 

MATLAB can present data as 2 and 3 dimensional plots. The plots can be 
created from the command line with both linear and logarithmic scales and 
edited interactively in the Figures Window. 

3.2 2-D plots from data sets 

3.2.1 The plot function 

MATLAB provides a number of functions for 2 D plots. The three basic 
versions are 

plot ( y ) 

plot ( x , y [ , x , y ] ) 

plot ( x , y , 'colour_style_marker' [ , x , y , 'colour_style_marker' ]) 

The first form of the MATLAB plot command is plot ( y ) where y is a vector 
of values. This plots the values of y against the indices, that is the pairs           
( n , y ( n ) ) with n =1 , . . . , length ( y ). 

Example 

y = rand ( 1, 10 ); % create a vector of 10 uniform random numbers 

plot ( y ) 
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The general 2-D plot command is based on pairs of (x, y) values as given 
by the vectors x and y (which must therefore be of equal length). 

Example 

x = 0 : 0.1 : 5 ; 

y0 = exp ( - x ); 

plot ( x , y0 ) 

will plot the exponential decay function in the range from 0 to 5 in steps of 
0.1. 

3.2.2 Multiple graphs in a single plot 

It is possible to create multiple plots in a single graph by successively 
adding pairs of x and y vectors 

y1 = x .* exp ( - x ); 

y2 = x .^ 2 .* exp ( - x ); 

plot ( x , y0 , x , y1 , x , y2 ) 

This will produce a graph with a plot of the vectors y0, y1 and y2 with 
different colours, selected according to the current setting in MATLAB. 

3.2.3 Line style of a graph 

With the third version of the plot function it is possible to control the style 
(colour, type of line and marker) of individual graphs as well 

plot ( x , y , 'colour_style_marker' [ , x , y , 'colour_style_marker' ]) 

Here 'colour_style_marker' is a string formed by concatenation of up to 
three character strings; for colour, type of line and marker. The available 
values are listed in the tables below. 

Available line colours are: 

cyan magenta yellow red green blue white black 

‘c’ ‘m’ ‘y’ ‘r’ ‘g’ ‘b’ ‘w’ ‘k’ 

Available line styles with their character representation are: 

solid dashed dotted dash-dot 

‘-‘ ‘--‘ ‘:’ ‘-.’ 

Available marker types are 

‘+’ ‘o’ ‘*’ ‘x’ 

Available filled marker types are 

square diamond up 
triangle 

down 
triangle 

right 
triangle 

left 
triangle 

penta 
gram 

hexa 
gram 

‘s’ ‘d’ ‘^’ ‘v’ ‘>’ ‘<’ ‘p’ ‘h’ 
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The character string for each style is unique so the order and number of 
character strings is not important, if a string is absent MATLAB will use 
default values. 

For example, plotting the above three vectors with different colours and 
markers: 

plot ( x , y0 , 'k-x' , x , y1 , x , y2 , ':m>' ) 

3.2.4 Clearing the content of the Figures Window 

To clear the content of the Figures window select the Edit > Clear Figure 
menu item from the Figures window menu bar or from the MATLAB main 
menu, depending on whether the window is undocked or docked 
respectively.  

However it may be quicker to enter the command 

clf 

in the Command Window. 

3.2.5 Adding Graphs to an existing Plot 

The plot command allows the creation of several graphs in a single call as 
shown before. But it is also possible to add graphs to an already existing 
plot with the hold command. 

hold on 

will add the graphs created by the next plot commands to the current plot 
until the command 

hold off 

is entered, which switches this feature off. 

3.2.6 Controlling the Plot Axes 

By default MATLAB uses the given range of x values for the x-axis and 
selects the range of the y axis such that all graphs will fit. 
 
To change only the limits of the x-axis in the Command Window use the 
function 
 
axis ( [ xmin   xmax ] ) 

and 

axis ( [ xmin   xmax   ymin    ymax ] ) 

to change both axis limits to the values of the arguments (note that the 
values are separated by spaces). 
 
An alternative set of functions that apply to individual axes are  

xlim ( [ xmin   xmax ] ) 

and 

ylim ( [ ymin   ymax ] ) 

The command 
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axis auto 

re-enables the automatic limit selection of MATLAB. 

Axes Aspect Ratio and Visibility 

The axes aspect ratio of the graph is controlled with the axis command. 
Use 

axis square 

to make the x and y- axes of the same length on the display. The command 

axis equal 

makes the individual tick mark increments the same length. 

The axes can be hidden with the command 
 
axis off 

and made visible again with 

axis on 

Labels 

The axes can be provided with labels to explain their meaning with the 
xlabel and ylabel commands which add labels to the respective axes. For 
example 

xlabel ( ‘x’ ) 

ylabel ( ‘y’ ) 

3.2.7 The Graph Title 

The graph can be decorated with a title with the function title which takes a 
string as argument, for example 

 title ( ‘Plots of various exponentially decaying functions’ ) 

3.2.8 Descriptive Text in the Graph 

Text with descriptive information can be placed anywhere in the graph with 
the text command. 

text ( x , y ,  ‘text_string’ ) 

where x and y are the coordinates where the text string has to start. 
However this can be done more conveniently in the Plot Editing Mode 
(Section 3.6) once a final version of the graph is completed. 

Legend 

This identifies the plots with some text enclosed in a box 

legend ( ' text '  [ , ' text ' ] ); 

3.2.9 Special Symbols in the Graph Annotation using TeX notation 

MATLAB has a limited capability to display special symbols, including 
Greek characters, in any graph text using a TeX notation. For example the 
individual graphs in the plot of exponential decay functions can be 
annotated. Create a script with these lines and save as the file 
exp_decay.m 



Guide 7: An introduction to MATLAB 21 

%exponential decay plots 

x = 0 : 0.1 : 5; 

y0 = exp ( - x ); 

y1 = x .* exp ( - x ); 

y2 = x .^ 2 .* exp ( - x ); 

plot ( x , y0 , x , y1 , x , y2 ) 

xlabel ( 'x' ) 

ylabel ( 'y' ) 

title ( 'Graph of the functions x^{n} e^{-x} for 

n=0,1,2' ) 

legend ( 'e^{-x}' , 'x e^{-x}' , 'x^{2} e^{-x}' ) 

 
Entering the command 
 
exp_decay_plot 
 
will produce a graph similar to this: 
 

 

 

An alternative method of plotting several graphs uses the plot command 
with the vectors collected in an array with the same number of rows or 
columns as the length of the x vector. In the exponential decay example the 
three row vectors of function values y0, y1 and y2 can be combined into an 
array with as many columns or rows as the length of the row vector x. For 
example in the former case with three rows 

clf 

plot ( x , [ y0 ; y1 ; y2 ] ) 
 

and in the latter case with three columns, giving the same plot  

clf 

plot ( x , [ y0’ , y1’ , y2’ ] ) 

 

3.2.10 Grid Lines 

Grid lines can be displayed in the graph with the statement 

grid on 
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and switched off with 

grid off 

3.3 Saving a Figure/Graph to a File 

To save a figure, select the Save As… command from the File menu of the 
Figures window if the window is undocked or from the MATLAB main 
menu if the window is docked. Alternatively, clicking the Save Figure button 
on the Toolbar of the Figures window will achieve the same. This will open 
the Save As dialog box which has a number of options to select the way 
the graph can be saved to a file. It offers various formats in which the figure 
can be saved. 

3.4 Activating or Opening a new Figures Window 

The plot functions automatically open a new figures window if one is not 
already open. If one or more are open then the output of the plot functions 
will be displayed in the currently active Figure window. To open another, 
new, Figure window enter the command 

figure 

before using the plot command. 

3.5 Viewing the content of the Figures window 

The Figures Window has several commands to view details of the graphs. 
These can be accessed from its Toolbar or from the Tools menu. A small 
selection is described below. 

3.5.1 Zoom In and Zoom Out. 

It is possible to zoom in or out of the graph. From the Tools menu select 
Zoom In or Zoom Out or from the Toolbar on the Figures Window click the 
appropriate Zoom In or Zoom Out button. 

 

3.5.2 Panning a Graph 

Panning controls what part of the plot is visible within the Figures Window. 
Select this mode with the Toolbar button Pan. 

 

3.6 Interactive editing of plots in the Plot Editing Mode 

This mode can be selected from the View menu of the Figures Window  
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by selecting Property Editor. The various items that are visible in the 
Figures window are called Graphics Objects in MATLAB. These can be the 
individual plots, the labels and axes, the legend, the title etc. The Editor 
offers a number of facilities to both view the graph in different ways and to 
modify the Graphics Objects that it contains. 

3.7 3-D plots for data sets 

MATLAB provides two methods for plotting data in three dimensions 

 Mesh Plots 
This defines a surface of z coordinates of points above a grid in the 
x – y plane 

 Surface plots. 
These plots are like mesh plots but the surface of the plot is no 
longer transparent. The display can be modified in various ways by 
controlling the illumination and viewing angle. 

3.8 Plots of Functions of One and Two Variables 

Plotting of functions requires a function handle and this topic will be 
discussed in Section 4.  

3.9 Exercises 

Simplify the commands in the example at the end of Section 3.2.9 by using 
the expressions in the plot function instead of using the vectors y0, y1 and 
y2. 

4 More about Functions 

4.1 Function functions and Function handles 

A variety of problems makes it necessary to use a function that has to 
perform an action on another function, usually defined by the user. 
Examples are root finding, numerical integration, optimization and finding 
minima and maxima of a function. 
In those cases a function is used as a global object and in MATLAB this is 
implemented as a reference or handle that has to be assigned to the 
function. The handle is obtained by preceding the function name with the 
‘at’ operator represented by the symbol @. For example a handle to the 
built-in sine function is defined as 
 
handle_sin = @ sin ; 
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Function handles come to their right in “function” functions in MATLAB and 
enable the use of functions as arguments of other functions. 
 
An important example is quadrature. This is the numerical integration of a 
function over a prescribed interval. MATLAB provides a number of 
“function" functions for this purpose. The simplest is quad2, which uses 
adaptive Simpson integration, 
 

value  = quad (  function_handle  ,  lower_bound  ,  upper_bound  ) 
 
For example the numerical value of integration the sin function from 0 to pi 
gives 

quad ( handle_sin, 0.0,  pi ) 

ans = 

    2.0000 

The @ operator can also be used inside the “function” function with the 
same effect 

quad ( @ sin, 0.0,  pi ) 

 

4.2 Plotting functions 

Functions can be plotted for one and two input arguments.  

Note There is an inconsistency in notation. The plot functions of 
Section 3.2 have the independent variable preceding the depending 
variable, for function plotting this order is reversed. 

4.2.1 Plot of a function of one variable 

In 2D this is the function fplot which is in it simplest format 

fplot (  function_handle  ,  limits  ) 

where limits can be used for the x range only by placing the range in 
square brackets, 

[  xmin   xmax  ] 

or for setting both X and Y range 

[  xmin   xmax   ymin    ymax  ] 

As an example plot the function sin using its handle on the interval 
[ 0.0, pi ] 

fplot ( @sin , [ 0.0 pi ] ) 

4.2.2 Plot of a function of two variables 

Functions of two variables can also be visualized, with the ezplot, ezmesh 
and ezsurf functions. 

ezplot ( fun , [ min , max ] ) 

ezplot ( fun , [ xmin , xmax , ymin , ymax ] ) 

                                                           
2 In new versions of MATLAB the function name quad will be replaced by integral 
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ezsurf ( fun ) 

ezsurf  (fun , domain ) 

where the domain can be either a row vector [ xmin ,  xmax ,  ymin ,  ymax] 
or row vector [ min , max ] (where min < x < max, min < y < max).  

An example is the sinc function in 2 variables: 

function z = sinc2d ( x , y ) 

r = sqrt ( x .^ 2 + y .^ 2 + eps );  

% eps added to avoid a singularity at the origin 

z = sin ( r ) ./ r; 

 

If this function is written as an M-file sinc2d.m it can be plotted as a 3D 
mesh: 
 
ezmesh ( @ sinc2d , [-10, 10, -10, 10] ) 
 
 

 
 
whereas the ezsurf command will display this as a surface. 

4.3 Anonymous Functions 

The function handle can also be used to define unnamed functions. For 
example, MATLAB enables the construction of simple functions as a single 
statement without giving it a name but instead referring to it with a function 
handle. The format is 
 
handle = @ ( function_argument_list )  anonymous_function_definition 
 
Example 
 
sqr = @ ( x ) x .^ 2 ;  % returns the square of the input 

value 

a = sqr ( 5 ) 

a = 

    25 
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and 

sqr(1:1:4) 

ans = 

     1     4     9    16 

Since an anonymous function is actually defined through its function 
handle, it can also be used as an argument in a “function” function. For 
example, to integrate the anonymous function sqr between 0 and 1, 
 
quad ( sqr , 0 , 1 ) 

ans = 

    0.3333 

The same can be achieved with using the definition of the function sqr 
inside quad 

quad ( @(x) x .^ 2 , 0 , 1 ) 

Another example is the two dimensional Gaussian function defined as an 
anonymous function 

gauss2d = @ ( x, y ) ( exp ( - ( x .^ 2 + y .^ 2 ) ) ) ; 

This function can be displayed as a mesh with the ezmesh function, 

ezmesh ( gauss2d, [ -2 , 2 , -2 , 2 ] ) 

as shown in the graph below, 

 

 

4.3.1 An Advanced Example 

A more advanced example of “function” functions is given here based on 
the normal distribution function, familiar for example in statistics. A normal 

random variable X with zero mean and standard deviation   has a 

probability distribution 
 

  









 2
exp

2

1 2x
xp  
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where x can take any real value. This means that the probability of the 
value of X to be between a and b is the definite integral 

 

b

a

dxxpbxaP )(  

Here  xp  is actually a function of two variables, x and , but   plays a 

special role as it determines the shape of the distribution. An example of 
code for this function with the name normal in an M-file normal.m is 

function r = normal ( x , sigma ) 

r = 1 ./ sqrt(2 .* pi .* sigma * exp(-x .^ 2 ./ (2 .* 

sigma)); 

 

To plot this function for a range of x values with   as parameter with the 

fplot function, the value of   has to be specified 

sigma = 1.0; 

fplot ( @ ( x ) normal ( x , sigma) , [ -3.0 3.0 ] ) 

To evaluate the probability between -1 and 1 for this value of sigma the 
quad function can be used 

quad ( @ ( x ) normal ( x , 1.0 ) , -1.0 , 1.0 ) 

ans = 

    0.6827 

Sometimes the cumulative probability 

 




x

dpxC )(  

is required for the normal distribution with standard deviation  . A function 

for this purpose could be defined as 

function f = normal_cum (x,sigma) 

% this function returns the cumulative probability 

between -Inf and 

% x for the normal distribution with standard deviation 

sigma  

f = quad(@(x) normal(x,sigma ), -10.0,x ); 

% Note: In this example the lower value of the 

integration range  

% has been set to -10.0 

 

and stored in an M-file normal_cum.m A plot of both the normal and 
cumulative normal distributions could be made with this M script: 
 
hold on 

fplot(@(x) normal(x,1.0), [-3.0,3.0]); 

fplot(@(x) normal_cum(x,1.0), [-3.0,3.0]); 

hold off 
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5 Programming in MATLAB 

MATLAB provides extensive programming features and the following 
provides just an introduction. 

5.1 Program Flow Control 

Every programming language provides a number of methods to control 
when and what statements are executed and in which order. Although the 
keywords are different for different languages these constructs usually 
provide the same functionality.  

Some of MATLAB basic control constructs are 

 Conditional Statements 

 Selection Statements 

 Repetitive Statements 

5.2 Conditional Constructs 

The “if end” construct evaluates a logical expression and when the result is 

true executes a group of statements. 
 
if   logical_expression 

  statements_block 

end 
 
As MATLAB is based on matrices and arrays a careful distinction has to be 
made when comparing two arrays, either as a whole or comparing on an 
element by element basis. If a and b are scalars the expression a == b will 
return either 0 or 1 (false or true). However, if a and b are matrices then this 
test will return a matrix of zeros and ones where a 1 indicates that the two 
corresponding elements are equal and a 0 that they are not. To test 
whether all corresponding elements of a and b are equal the function 
isequal has to be used which will return a scalar result.  

The “if else end” construct 
 

if   logical_expression 

 statements_block_1  

else 
 statements_block_2  

end 
 
and the if elseif end construct 

 
if   logical_expression 

 statements_block_1  

elseif 
 statements_block_2  

... more elseif statements … 
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else 
 statements_block 

end 

 

 

 

Example  

Roots of a quadratic equation 

𝑎 𝑥2 + 𝑏 𝑥 + 𝑐 = 0  

d = b ^ 2 - 4 * a * c; 

if d > 0.0 

 disp ( ‘two distinct real roots’ ); 

elseif d == 0.0 

 disp ( ‘double real root’ ); 

else 

 disp ( ‘pair of complex conjugate roots’ ); 

end 

 

5.3 The Selection Construct 

Often it is required to test a variable or expression that can attain a known 
set of values. This is best done with the switch construct. 
 
switch   expression 
 
    case   value1 
 
       statements_block_1 
 
    case   value2 
 
       statements_block_2 
... 
 
    otherwise 
 
        default_block 
end 
 
Note MATLAB’s switch does not “fall through” unlike in e.g. the C 
language. The statement block of the first matching case is executed and 
the switch statement then terminates. MATLAB has no break statements to 
define the end of a case block. 

5.4 The Repetition and Iteration Constructs 

5.4.1 The for loop 

The “for loop” repeats a block of statements for a fixed pre-set number of 
times.  
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for  index  =  start_value  [  : increment ]  :  stop_value  
 
         statement_block 
 
end 

start_value, increment and stop_value must take on integer values. The 
increment can take on positive and negative values; the default value is 1, 
e.g. 

for  index  =  start_value   :   stop_value 
 
          statement_block 
 
end 

For positive increment execution terminates when index is greater than 
stop_value, whereas for negative values when index is less than 
stop_value. 

The next example is a function that calculates the factorial of a non-
negative integer. 

Example 

function f = fact_prod ( n ) 

% function returns the value of n factorial n! = 1.2.3 

... (n-1).n 

% for integers n >= 0 and 0! = 1 by calculating the 

product 

 

f = 1; 

for i = 1 : n 

    f = f * i; 

end  

 

5.4.2 The while loop 

The while loop executes a block of statements an indefinite number of 
times under control of a logical condition. 

while   logical_expression 

statement_block 

end 

In the following example the first integer n is found for which n factorial (n !) 
is a 100-digit number. (Note that this is a very inefficient way to solve this 
problem.) 

Example 

n = 1; 

while prod ( 1 : n ) < 10e100 

    n = n + 1; 

end 

display ( n ) 

The MATLAB function prod returns the product of the integers from 1 to n. 
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help prod 

provides more details. 

5.4.3 The continue statement 

The continue statement passes control to the next iteration of a for or 
while loop, skipping any remaining statements in the body of the loop. 

5.4.4 The break statement 

The break statement will cause an early exit from a for or while loop. 

5.5 Example: The Collatz Problem 

The Collatz problem considers the construction of a sequence of integers 
taking any arbitrary positive integer as starting point. Here is the algorithm 
to construct the sequence: If n is an integer in the sequence then the next 
integer is computed as follows. If n is even divide it by 2, if n is odd multiply 
it by 3 and add 1. The Collatz conjecture states that the sequence will 
reach the value 1 in a finite number of steps. The length of the sequence 
varies and depends on the starting value. 
 
For example, for n = 1 the sequence is [ 1 ], for n = 2 it is [ 2, 1 ] and for n = 
3 it is [ 3, 10, 5, 16, 8, 4, 2, 1 ]. 

This is an example of a function to calculate the Collatz sequence, given a 
starting value n. 
 
function sequence  = collatz ( n ) 

% The Collatz problem. Attempts to find for any  

% positive start value n the sequence of integers. 

 

sequence = n; 

i = n; 

while i > 1 

    if rem ( i , 2 ) == 0 % rem returns the remainder 

on division of i by 2 

        i = i / 2; 

    else 

        i = 3 * i + 1; 

    end 

    sequence = [ sequence , i ]; 

end 

 
The length of the sequence can be plotted against the starting value with 
the following function: 
 
function collatz_plot ( n ) 

% This plots the length of the Collatz sequence for all 

positive integers 

% between 1 and n. 

 

clf 

for m = 1 : n 

    seq  = collatz ( m ) % the Collatz sequence for 

integer m 
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    plot ( m , length ( seq ) ) 

end 

 

 

  

5.6 Exercises 

5-1 Write a function fact(n) = n! to calculate the factorial using its recursive 
property, fact(n) = n * fact(n-1).  

MATLAB provides a function factorial for this purpose and the code can be 
displayed with the command 

type factorial 

5-2 Rewrite the example in Section 5.4.2 such that the next value for n 
uses the previous result (for example use a for loop and not the MATLAB 
function prod) 

5-3 Code the Collatz problem and test the function for n = 1, 2, 3. Try some 
bigger values of n. Plot the sequence length for a range of values of n. 

5-4 User a quicker way of finding the length of the Collatz sequences by 
storing previous results. 


